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4. Click the Insert Subdocument button, pick the first document in sequence, 

and click OK.  
 

5. Press <Ctrl+End> to go to the end of the first document. Backspace so that 
you delete the section break at the bottom of the inserted document.  

 
6. With the cursor on a new line (at the end of the first section), click Insert 

Subdocument again.  
 

7. Pick the second document to be inserted and click OK. The first two 
subdocuments are inserted.  

 
8. Again, delete the last section break and put the cursor on a new line at the 

bottom of the last section. Then insert the third subdocument as above.  
 

9. Continue inserting your subdocuments in the proper order until all are 
included within your master document.  

 
Starting Each Section on a New Page  
 
Now set the Layout tab of the Page Setup dialog as shown so that each section 
starts on a new page.  
 
Tip:  
 
In this procedure you start each new subdocument on a new page. However, if 
you want to start each subdocument (or “chapter”) on a right-hand page, as is 
the practice with many printed books, select Odd Page instead of New Page. 
Right-hand pages are always odd-numbered. Conversely, even-numbered 
pages are always on the left-hand side when the book is lying open. Check 
Different Odd and Even if you want to alternate the copy and/or placement of 
headers and footers. Check Different First Page if you want to omit a header 
and/or footer on the opening page of each subdocument (or chapter).  
 
1. Move to each subsection and set the Layout tab of the File / Page Setup 

dialog as shown in the following illustration.  
 
2. Be sure that every subdocument (or chapter) has been set up so that each of 

your sections starts on a new page. Also check the Different Odd and Even 



 
 
 
 
 
Computer Fundamentals and Office Automation 

Centre for Information Technology and Engineering, Manonmaniam Sundaranar University 144

and Different First Page check boxes. If you think you missed a section, it’s 
easy to check. Simply put the cursor in the subdocument and display the 
Page Setup dialog to display your settings. Change as necessary.  

 
3. Click the Print Preview button on the Standard toolbar to ensure that every 

subdocument starts on a new page.  

 
Adding Headers and Footers  

 
In the preceding section you provided for different odd and even pages and 
first pages using the check boxes. With these settings in place, you can add 
alternating headers and footers.  
 
1. Use the View / Header and Footer menu selection to enter header and 

footer text.  
 
2. Use Align left for even-numbered headers and footers and Align Right for 

odd-numbered headers and footers.  
 

3. Go to the first page of the first subdocument that uses Arabic page numbers. 
Then move to the footer (using View / Header and Footer).  

 
4. Click the Page Numbers button on the Header and Footer toolbar to insert a 

page number.  
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5. Use the Insert / Page Number menu selection to set the first number to 1. 
Set the Alignment to outside. Click the Format button and select the number 
style and starting value. Click OK twice to close both dialogs.  

 
6. Set the page number font, point size, and weight (bold, italic, etc.) to your 

preferences.  
 

7. Close the Header and Footer toolbar. Then use Page Preview to examine 
each page number and its placement. Make adjustments as necessary.  

 
Tip:  
 
You can use the Page Setup button on the Header and Footer toolbar to make 
any necessary page layout adjustments. Pay particular attention to the Same As 
Previous button to ensure that unwanted header or footer information is not 
carried over from the previous section.  
 
8. Once the headers and footers are properly adjusted and examined, you are 

ready to create a table of contents.  
 
Creating a Table of Contents or Figures  
 
If your section headings and titles use the styles on the Formatting toolbar, then 
creating an automatic table of contents is easy.  
 
Once styles are applied to all headings (such as Heading 1, Heading 2, etc.), 
place the cursor at the position where the table of contents should begin. Then 
use the Insert / Index and Tables menu selection to display the Index and 
Tables dialog. Click on the Table of Contents tab, and select the format you like 
(check it in the Preview box). Use the Options and Modify buttons if you wish 
to change the order, add more heading levels, or insert a custom heading style. 
Click OK once all is set up to your liking.  
 
To create a table of figures, use the Table of Figures tab is used in the Index and 
Tables dialog.  
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Creating an Alphabetical Index  
 
It is an easy matter to mark various text entries for inclusion in an alphabetical 
index. Indexes are normally found at the end of a multi chapter document.  
 
First, find and highlight (drag) the word or phrase you want to include. Then 
use the Insert / Index and Tables menu selection to display the Index and 
Tables dialog. Click the Index tab. Then click the Mark Entry button. The 
selected word or phrase is displayed as the Main Entry on the Mark Index 
Entry dialog as shown here.  
 
Click Mark on the Mark Entry Index dialog (or Mark All to find every 
occurrence of a word or phrase). Then click Close and move to the next word to 
be indexed.  
 
Tip:  
 
You can type alternate forms of the word or phrase to help your readers locate 
information. You can also use subentries that are printed below a main word, 
such as:  
 
 Potato 
         Baked 
         Boiled 
         Fried  
 
Place the cursor at the index insertion point within your document, then use the 
Index tab of the Index and Tables dialog to pick the format you want to use. 
Click OK; the index is compiled and inserted in the specified format.  
 
Hands-on Activities  
 
Inserting Subdocuments  
 
1. Use the View / Outline Document menu selection to display the Outlining 

and Master Document toolbars.  
 
2. Click the Insert Subdocument button on the Master document toolbar, 

select the Basics00.doc companion file, and click Open.  
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3. Press <Ctrl+End> to move to the end of the document.  
 

4. Put the cursor on a blank line at the extreme bottom of the document. Be 
sure that there is a carriage return on the line above the cursor. Then click 
Insert Subdocument, select Basics01.doc, and click Open.  

 
5. Repeat steps 3 and 4 and insert the remaining files Basics02.doc through 

Basics06.doc. Respond by clicking No to All when the Title 1 Style already 
exists dialog is displayed.  

 
Starting Each Section (or Subdocument) on an Odd-Numbered, Right-
Hand Page  
 
6. Go to each subdocument and set the Layout tab of the Page Setup dialog as 

shown here:  
 
Inserting Headers and Footers; Putting Page Numbers in the Footers  
 
7. Go to the beginning of the first subdocument. Use the View / Print Layout 
menu selection.  
 

a. Use the View / Header and Footer menu selection to display the Header 
and Footer toolbar.  

 
b. Click the Switch Between Header and Footer button to move to the 

footer of the title page (first page of the first subdocument).  
 

c. Click the Insert Page Numbers button on the Header and Footer toolbar.  
 

d. Click Format Page Number and set the page number value to small 
Roman letter i. (This is the convention normally used for the front matter 
of a book.) Click Start at and verify that it is i.  

 
e. Click OK. Then click Close to close the Header and Footer toolbar.  

 
f. Use Insert / Page Numbers and set the Alignment to Outside. Make sure 

Show number on first page is not checked.  
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8. Go to the beginning of the second subdocument (named “Section 1”). 
Repeat 7a through 7f above, setting the Page Numbers dialog as shown in 
the two illustrations shown here. (This starts the first section with page 
number 1 on an odd-numbered, right-hand page.)  

 
9. Go to the beginning of each of the remaining subdocuments. Repeat 7a 

through 7f above, setting the Page Number Format dialog as shown in the 
illustration at right. (Note that these continue the page numbering scheme 
from the previous sections. Also, each new section starts with an odd 
number.)  

 
Tip:  
 
When even-numbered pages are blank (called a blank back), they are skipped. 
For example, if page 7 has a blank back, blank page 8 is skipped. Page 9 starts 
the next section on an odd-numbered, right-hand page.  
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Construct a Table of Contents  
 
10. Go to the second page. Move the cursor to the blank line following the word 

“Contents.”  
 
11. Use the Insert / Index and Tables menu selection and click the Table of 

Contents tab.  
 

12. Click the Options button. Set the TOC Level numbers opposite the 
Available Styles as listed below. Scroll down to the Heading 1 heading and 
put 1 in the TOC Level box. Be sure that all unused headings are blank 
except for those shown in the following list.  

 
Available Styles     TOC Level           Available Styles     TOC Level 

Title 1              1          Heading1          2 

Heading2          3          Heading3          4  

 
13. Click OK. Your dialog should resemble this one:  
 
14. Click OK again to compile the table of contents. When completed, you have 

a full table of contents with heading names, dot leaders, and page numbers.  
 
Tip:  
If you make changes and want to recompile the table of contents, click on the 
table of contents with your mouse to select it. Delete it (with Del). Then repeat 
steps 11 through 14 as necessary to recompile the table of contents to the 
current document configuration.  
 
Construct an Alphabetical Index:  
 
15. Select ten or twelve headings, words, and phrases for inclusion in an 

alphabetical index as follows:  
 

a. Drag the first selection so that it is highlighted (such as “Seeing what’s on 
your computer”).  
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b. Using the Insert / Index and Tables menu selection, click the Index tab 
and click Mark Entry. Your dialog should resemble the following one:  

 
c. Click Mark to identify the entry for your index.  

 
d. Close the dialog and continue selecting and marking entries until you 

have selected ten or twelve. Notice that “XE” field codes are inserted 
following each selection.  

 
Tip:  
You can also position your cursor, use the Insert / Field menu selection, and 
use the dialog as shown here to manually enter your index entries.  
 
16. Place the cursor on the line following the word “Index” in the last 

subdocument.  
 
17. Use the Insert / Index and Tables menu selection and click the Index tab.  
18. Select the Classic format as shown in the following illustration and click OK 

to compile the index.  
 
19. Notice that the index is inserted at the cursor position.  
 
Examine the Paginated Document Using Print Preview or By Printing It  
 
20. Press <Ctrl+Home> to go to the top of the document.  
 
21. Click the Page Preview button on the Standard toolbar.  
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22. Display two to four pages at a time using the Multiple Pages button.  
 

23. Page through the document checking the layout and page numbering. If you 
wish, you can click the Print button to see the actual output.  

 
Finishing Up  
 
This completes the master document activity. As you can see, master 
documents are ideal for creating large, multi chapter documents. Now you can 
exit Word without saving or, if you prefer, save the document for additional 
experimentation. When saved, sections are automatically locked to protect the 
integrity of the document. Use the Lock Document button on the Master 
Document toolbar to unlock each subdocument when changes are required. If 
you have time for another practice activity, try adding alternating right- and 
left-hand headers. Here, add the book title to left-hand page headers and the 
section number to the right-hand page headers. Put the headers at the outside 
of each page. You should also omit headers from the first page of each section, 
which is a common publishing practice. You may also want to see how easy it is 
to promote and demote heading styles using the Outlining toolbar. Just put the 
cursor on a paragraph heading and click the buttons to see how they work.  
 

8.4 Merging Envelops & Labels 
 
There is nothing quite as pathetic as receiving a perfectly printed letter, with 
gorgeous fonts and graphics, in an envelope where the sender scrawled the 
address by hand. Unless of course, it’s the pitiful sight of watching someone 
run an envelope through a typewriter when a laser printer is right alongside. 
After you learn how easy it is to create envelopes and labels with Word, you 
will never need that typewriter again. 
 
Printing a single Envelope 
 
You can create a single envelope from information on a letter or in its own 
document. 
 
Creating a single Envelope 
 
1. Open the letter for which you want to create an envelope and select the 

recipient’s address. 
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2. Choose the Tools menu, select Envelops and Labels, and click the Envelops 

tab. The selected text appears in the Delivery address box. 
 

3. If necessary, type your address in the Return address box. 
 

4. The default format is a standard U.S # 10 envelope. To select a different 
format, click the Options button. 

 
5. Choose the Add to Document to insert the envelope at the top of the active 

document. Click Print to send the envelope directly to the printer. 
 
Printing Labels 
 
Word users can take advantage of three main label-printing options. You can 
print a single label, a sheet of the same label, or labels that corresponds to a 
mail merge data source. 
 
Printing a Single Label or Sheet of Labels 
 
1. From any document, choose the Tools menu, select Envelops and Labels, 

and click the Labels Tab. The Envelops and Labels dialog box appears. 
 
2. In the Address box, enter the information you want to appear on the label. 

 
3. In the Print box, select Single label, and then enter the row and column 

number for the label on which you want to print. This technique allows you 
to use a sheet of preprinted labels repeatedly without wasting any. 

 
4. Click the Options button and specify the manufacturer and product number 

for the style of labels you are using; then click OK> 
 

5. To send the label directly to the printer, click the Print button. To create a 
new Word document with the correct formatting for your label, click the 
new document button. 
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8.5 Short Summary  
 
♣ The Tools / Mail Merge menu selection is used to merge a list of 

information, such as names, addresses, and phone numbers (called data or 
data source) into what is called a main document 

 
♣ Word’s master document feature, which is accessed using View / Outline, is 

used to combine two or more documents into a larger, fully paginated 
document 

 
 

 


